
1 

  

Cisco WebEx Connect Release Notes 
Version: 7.1 

Date: September 30, 2011  

 

These release notes describe the Cisco WebEx Connect version 7.0 and 7.1 new features and known issues: 

• What’s New in the 7.1 Release? 
• What’s New in the 7.0 Release? 
• Known Issues/Limitations 
• Related Documentation 

 

What’s New in the 7.1 Release? 

Lotus Notes calendar 
integration 

Integration with IBM Lotus Notes: New in Cisco WebEx Connect version 7.1 is the integration with the 
IBM Lotus Notes calendar. Meetings scheduled in Lotus Notes appear in the Meetings tab in Cisco 
WebEx Connect. Meetings that have an associated WebEx meeting can also be started or joined from this 
tab and from the meeting reminders. If a Lotus Notes meeting does not have a WebEx meeting 
associated with it, an instant WebEx meeting can be started for that meeting. 
This option is available in user preferences and users can turn it off, if preferred. The feature requires the 
Lotus Notes desktop client to be installed on the user’s computer. 

Improved platform 
support 

Improvements to platform, browser, and application support: In addition to previous platform support, 
Cisco WebEx Connect version 7.1 includes support for the following platforms, browsers, and 
applications: 

• Citrix Xen Desktop 5 on Windows 7 SP1 and Windows XP SP3 
• Internet Explorer 9. Internet Explorer users must install the Microsoft update package from the 

link available in the following Microsoft article: http://support.microsoft.com/kb/2488113. 
• Windows 7 SP1 
• Microsoft Outlook 64-bit support for calendar integration 

Additional languages More language support: In addition to the languages currently supported, Cisco WebEx Connect version 
7.1 supports the following languages: 

• Traditional Chinese 
• Dutch 
• Brazilian Portuguese 
• Russian 
• European Spanish 

Serbia now supported 
for registering users 

Registering users in Serbia: Support for Serbia as a new country option for registering users in the 
Cisco WebEx Administration Tool. 

High-definition video 
feature 

High-definition video feature: Cisco WebEx Connect version 7.1 introduces support for a high-definition 
video feature (up to 720p) for PC-to-PC calls. 
 
Administrators can control the high-definition video feature through a new policy in the Policy Editor of the 
Cisco WebEx Connect Administraton Tool. 

Screen capture Controlling the screen capture feature with the Policy Editor: The ability to send and receive a screen 
capture can now be controlled through the Policy Editor in the Cisco WebEx Connect Administration Tool. 
For more information about the screen capture feature, see the “Screen capture” item in What’s New in 
the 7.0 Release? 

http://support.microsoft.com/kb/2488113�
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Broadcast messages Controlling the broadcast message feature with the Policy Editor: The ability to send a broadcast 
message can now be controlled through the Policy Editor in the Cisco WebEx Connect Administration 
Tool. Also, the ability to send a broadcast message to an Enterprise Group is also now controlled through 
the Policy Editor in the Cisco WebEx Connect Administration Tool. For more information about the 
broadcast messages feature, see the “Broadcast messages” item in What’s New in the 7.0 Release? 

Plantronics Spokes 
Integration 

Integration with Plantronics Spokes software: Cisco WebEx Connect 7.1 introduces full support of both 
PC-to-PC calls and Cisco Unified Communications Integration with Spokes 2.4. 



What’s New in the 7.0 Release? 

3 

What’s New in the 7.0 Release? 

New look and feel New look and feel: Cisco WebEx Connect version 7.0 has been enhanced for improved user interface 
and usability. New fonts, colors, and icons lend themselves to better usability and visual appeal. 

Contact list and “hub” Better access to common functions and improved menus: The following enhancements have been 
added: 

• Improved communications: In addition to chat, it is easy to make calls when you hover over a 
contact name. This feature is available for users who have the Cisco Unified Communications 
Integration (Cisco UC Integration) for Cisco WebEx Connect. 

• Revised menus: Relevant actions have been consolidated into four menu items: File, 
Communicate, Actions, and Help. 

• Observer list: The Observer list has been moved to File > Change Preferences > Privacy and 
is always available. Observers can be added to the contact list, blocked, or removed from this list. 

• Friendly name: The Friendly Names command has been removed from the View menu. If you 
specify a friendly name for a contact, it always shows on the contact list. 

• Directory groups: Directory groups are indicated by a new icon. 

• Calendar tab: The Calendar tab has been renamed to the Meetings tab to more accurately 
reflect the list of WebEx and Microsoft Outlook meetings that are displayed there. 

• Status changes: You can set and change your custom status very easily regardless of which tab 
is active. An input box in the hub allows you to quickly change your status. 

• Presence icons: Accessibility indicators have been added to all presence icons. 

• Contact Card and Profile: The Contact card contains the most relevant information for business 
users. Information that was not used has been removed, including the Personal tab, Download 
vCard command, and Send Email command. In addition, the detailed profile also reflects the 
contact’s Jabber ID. 

Unified contact search Easily search for all of your contacts: This version of Cisco WebEx Connect introduces a powerful, 
predictive search, which allows you to search for all of your contacts, including contacts from the following 
sources: 

• Contact list 

• Connect directory 

• Personal contacts from Microsoft Outlook 

• Contacts who recently contacted you through IM, phone, or email 

The Search results start displaying as soon as you start typing a name, and typing more characters filters 
the search results. A maximum of 10 results are displayed at any one time, with the ability to see more 
contacts if there is no match. Contact names are displayed by friendly name, if it exists. If it does not, 
names are displayed by display name. If a contact does not have either a friendly name or a display name, 
their Jabber ID (JID) is displayed in the search results. 
 
Predictive search is available from the hub and also when you add a contact, invite a user to a group chat, 
and add users to send a broadcast message. 
When searching for a user in the hub, you can make the most common actions directly from the search 
results, including sending an IM to the contact, making a call to the contact, and adding the contact to the 
contact list, if they are not already listed. 
 
The Search feature greatly enhances productivity by allowing you to quickly find and communicate with 
your contacts, including those not on your contact list. 
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Integrated 
Conversations 

Seamlessly collaborate using IM, Audio, Video, and WebEx Meetings: You can easily expand IM 
conversations to include audio and video conversations using a single click. You can also share a desktop 
with your contact and start a WebEx meeting with a single click. A single conversation window allows you 
to hold, expand, manage and control all types of conversations. The following changes have been made to 
the conversation window: 

• Single window:  A single window for IM, audio, and video calls 

• Start calls using a single click: You have the option to specify a call using your computer (PC-
to-PC call) or using Cisco UC Integration with Cisco WebEx Connect 7.0 (if available). 

• Add video to calls: When you make computer calls (PC-to-PC calls), you have to option to add 
video to them. You can decide to send your video along with the audio call, with a single click. 
You can preference for including video by selecting File > Change Preferences > 
Audio/Video. You can choose to send video automatically, view a preview before sending video 
(default), or always start with an audio call. For the last option, you still have the ability to manually 
add video to your call later if you choose to do so. 

• Manage Phone Calls: 

o PC-to-PC calls: Start and end calls.   

o Unified Communications calls: Start and end calls, place calls on hold, transfer, 
conference, and send the call to your mobile phone (if configured).  Users in Soft Phone 
mode can mute the call and adjust receiving volume. 

• Manage video calls (PC-to-PC calls): Expand PC-to-PC calls to include video and preview your 
video before sending it. Use full-screen mode for a much more personal experience. 

• Share your desktop: A separate Share Your Desktop button allows you to start desktop sharing 
with a single click. 

• WebEx meetings: A separate WebEx Meetings button allows you to start a WebEx meeting with 
a single click, with invite sent to the contact automatically 

• History tab: The Archive tab has been renamed to the History tab. 

• Tab display: During an audio or video call, the Archive and Email tabs are not displayed. 

• Menus: To view menus, you can press the Alt key on your keyboard. Menus include File, 
Communicate, Edit, and Help. 

• Add a contact: If someone who is not one of your contacts sends you an IM message, you have 
the option to add them to your contact list from the conversation window itself, using a single 
click. 

• Chat: The Chat input box size is now flexible; you can now increase or decrease the box size 
manually. The input box also expands automatically as you type. 

• Ability to copy URL from IM window: A Copy URL command is available from the right-click 
menu in the IM window. 

• Expand to group chat: You can easily expand a one-to-one conversation to a group 
conversation. Group chats start in the same window, but the new invited contacts cannot view 
the original one-to-one conversation. 

• Audio conference: The Start Audio Conference option under Call now appears only for group 
chats. 

Enhanced meetings Start and join meetings seamlessly: Deeper integration with WebEx meetings allows a better and 
improved start and join experience, including the following enhancements: 

• Meetings tab: The Calendar tab is renamed to the Meetings tab to more accurately reflect the 
list of meetings that are displayed there, including WebEx meetings and Microsoft Outlook 
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meetings. WebEx meetings appear for the WebEx service site you have specified in File > 
Change Preferences > WebEx Meetings. 

• Focus on today’s meetings: The meeting list displays today’s meetings with the focus on the 
next upcoming meeting. You can navigate from one day to another or you can click on the 
calendar icon to select a day to view the meetings. 

• Meeting information: Meeting information in the Meeting tab includes the most relevant 
information about the meeting, including meeting name, time, and duration, host name and a 
Start or Join button that appears one hour before the meeting start time. The list of attendees no 
longer appears in this view, but you can click the More Details link to see the invitee list in 
Microsoft Outlook or your WebEx site. 

• Start and Join button: The Start and Join buttons, for hosts and attendees, respectively, appear 
one hour before the start time of the meeting. For past meetings, the only the host has a Start link 
and can start a past meeting. Users can join or start meetings with a single click. 

• Start a WebEx meeting for Microsoft Outlook meetings: For a meeting in your Meeting list that 
does not have a WebEx meeting associated with it, you can start an online meeting instantly by 
selecting the Start Online button. When you start a meeting this way, WebEx meeting invitations, 
including a link to join the meeting, are automatically sent by IM to all online meeting invitees and 
by email to invitees who are offline. This feature allows you to quickly start an online meeting at a 
short notice even if you had not scheduled one before. 

• Schedule, Edit, Delete meetings; Since the focus is on real-time communication, options to 
schedule, edit, and delete meetings are no longer available through Cisco WebEx Connect. You 
can still schedule, edit, and delete meetings from Microsoft Outlook or from your WebEx site.  

• WebEx meeting reminders: WebEx meeting reminders have the following improvements: 

• Display: Meeting reminders appear as a pop-up message at bottom right of the user’s screen. 
These reminders appear 15 minutes before the meeting start time and, if dismissed, show up 
again a minute before the meeting time. The reminders persist for 10 minutes after the meeting 
time unless you dismiss them or select Start or Join in the reminder. You can disable reminders 
by going to File > Change Preferences > Notification > Meeting Reminders. 

• Start and Join buttons: You can click Start or Join from a meeting reminder with one click if the 
meeting is on the same WebEx site that you have specified under File > Change Preferences > 
WebEx Meeting.  

• Countdown: The meeting reminders show, in real-time, the time left for the meeting to start or 
the amount of time the meeting is overdue. 

• Meeting information: The meeting reminders display the most relevant meeting information. 
Clicking on the meeting name in the reminder displays the Meetings tab in Cisco WebEx 
Connect, which provides more details about the meeting. 

• New “Sharing in a WebEx Meeting” status: A new status indicates that you are sharing your 
desktop, an application, or a document in a WebEx meeting. When you have the “Sharing in a 
WebEx Meeting” status, you are also in a Do Not Disturb mode, preventing interruptions and 
distractions in a WebEx meeting. 

These meeting enhancements are available only for users who have a host account on WebEx sites that 
are version WBS 27 SP22 or later. For versions WBS 27 SP21 and earlier, the start and join experience is 
the same as in earlier versions of Cisco WebEx Connect, and one-click Start and Join is not supported. 

Chat messages Specify a default “look” for IM messages: You can specify a default font, size, type, and color for your 
incoming and outgoing chat messages. You can specify these preferences in File > Change 
Preferences > General. 
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Group chat Improved group chat: Group chat includes the following enhancements: 

• Invite: Searching for contacts to invite for group chat is done using the new predictive search 

• Group chat window: When you expand a one-to-one conversation to a group chat, the group 
chat starts in the same window, but the one-to-one conversation is not displayed to the other, 
invited contacts. 

• Pending group: If an invited contact does not accept a group chat invitation, they now appear in 
a separate group called “Pending.” This group provides an easy way for you to know who has not 
yet accepted your invitation so you can either resend the invitation to them or contact them 
separately to follow up. 

• Resend invitations: Using a right-click command, you can resend invitations to a contact in the 
“Pending” group. 

• Drag and drop contacts: Contacts can also be dragged from the contact list into a group chat. 
This will result in the contact getting an invite for the group chat. 

• Audio icon: For audio group calls, an icon against the contact name displays that they have 
joined the audio conversation. 

Sessions panel Improved usability: The following new usability enhancements allow you to easily identify contacts you 
are chatting with: 

• Clear visual to indicate the contact you are chatting with. 

• Single-line display of contact name with user presence to accommodate more sessions. 

• When a contact sends a message, an alert shows up on the session panel with an indicator for 
the number of missed messages. 

• You can no longer undock and dock conversation windows into the session panel. Instead, you 
can choose to not use the session panel at all and choose a free floating model for your 
conversation windows. You can turn on this option under File > Change Preferences > 
General-> Chat sessions. 

Broadcast messages Ability to send announcement messages to a group of contacts at once: You can broadcast a 
message to a group of contacts at once. You can send a broadcast by selecting contacts or a group on 
your contact list and right clicking to enter and send broadcast message, or you can send it from the 
Communicate menu. You can also add additional contacts to a broadcast message window by dragging 
and dropping from the contacts list. Broadcast messages include the following features: 

• Messages can be broadcasted to a maximum of 1000 contacts at a time. 

• Messages are not sent to offline contacts. 

• A message cannot be sent to a mix of contacts and groups in the same message. 

• Broadcast messages do not support end-to-end encryption. 

• Messages are logged on the server-side, if IM logging is turned on. 

• Recipients cannot reply to the broadcast message. 

• Broadcast messages can be received by other Cisco WebEx Connect users who are using 
version 6.5 or later (earlier versions are not supported) 

The feature can be turned off in the Cisco WebEx Connect Administration Tool. Another setting in the 
Cisco WebEx Connect Administration Tool prevents users from sending broadcast messages to 
directory groups that they do not belong to, if directory groups are turned on for their organization by the 
administrator. 



What’s New in the 7.0 Release? 

7 

Presence Richer presence status to provide more relevant real-time information: The following presence status 
enhancements have been added: 

• Presence in the system tray: A persistent Cisco WebEx Connect icon in the Windows taskbar 
allows you to view your presence and change it directly from the taskbar.  

• New “Do Not Disturb” option: You can now set your “Do Not Disturb” status to not allow others 
to send messages or notifications to you. Phone calls and meeting reminders are still displayed. 
You can specify this option by selecting File > Change Preferences > Status. 

• Custom “Do Not Disturb” status: You can now specify a custom “Do Not Disturb” status in the 
hub. 

• New “Sharing in a WebEx Meeting” status: A new “Sharing in a WebEx Meeting” status 
indicates that you are sharing your desktop, an application, or a document in a WebEx. When you 
have the “Sharing in a WebEx Meeting” status, you are also in a “Do Not Disturb” mode, which 
prevents interruptions and distractions for a presenter in a WebEx meeting. 

Screen capture The following screen capture enhancements have been added: 

• Administrators can turn off screen captures in the Cisco WebEx Administration Tool for the 
entire organization. 

• When you create a screen capture, it gets pasted in the text area for your review first, before you 
send it. 

Cisco Unified 
Communications 
Integration (Phone 
Tab) 

When Cisco Unified Communications Integration is turned on, you can manage phone calls, easily 
expand IM conversations to phone calls, and you can preview your voicemail. The following 
enhancements have been added: 

• Call Management: You can now view and manage multiple call sessions at once.  You can start 
new calls or merge or conference existing calls.  You can also place calls on hold or send the 
calls to your mobile phone (if configured). 

 

• Recent Calls: The Recent Calls tab (inside the Phone tab) displays user contact and presence 
information and provides a quick and easy way to return calls. 

  

• Voicemail: If voicemail is turned on, you can view all of your voicemail messages in one location.  
You can choose which message to play, and can respond by calling back or sending an instant 
message the user.  User contact and presence information also displayed. 
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If voicemail is not turned on, you can call your Voicemail system by selecting Call Voicemail. 

• Keypad: You can use the keypad to start new calls or enter dial tone digits while on a call with an 
automated system. 

• Forward Call Power Switch: Easily turn on and off call forwarding capabilities.  You can use the 
Forward Call Power Switch at the bottom of the Phone tab to open the Call Forwarding Wizard.  
Chose to call forward to your voicemail, numbers in your profile, or any other number you 
choose. 

• Supported Architectures 

o Cisco Unified Communications Manager: 6.1(4) 
7.1(3) 
7.1(5) 
8.0 
8.5 
 

o Cisco Unity: 8.0 (3A) SU2* (with Microsoft Exchange 2003 o  
2007) 
 

o Cisco Unity Connection: 8.0* 
8.5* 
 

o Cisco IP Phone Endpoints: 6821 
6941 
7941 
7960 
7961 
7970 
7975 
8961 
9951 

*These versions are required only for Visual Voicemail. 
 

Korean language 
support 

Korean language support is added in Cisco WebEx Connect version 7, in addition to the English, German, 
Japanese, Simplified Chinese, French, Italian, and Latin American Spanish support that has been available 
in previous releases.  

Other Usability enhancements: Some other usability enhancements include: 

• Updated text in the installer. 

• Combined Remember User name and Password option in the sign-in window. This option is 
not turned on by default. 

• Removed notification to contact if a user removes them from the contact list. 

• Simplified date format for message history. 

Admin audit log The admin audit log feature records all the changes made by the administrators using the Cisco WebEx 
Connect Administration Tool. For every change made through the Cisco WebEx Connect Administration 
Tool, the audit log provides the following information: 

• The time the change was made 

• Administrator who made the change 
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• Item that was changed 

• Relevant details about the change 

Administrators can generate admin audit log reports by going to the Report section of the Cisco WebEx 
Connect Administration Tool and selecting Audit Trail for the report type. Administrators can generate 
the reports dating back up to 90 days. 

Automatic upgrade 
management 

The automatic upgrade management feature makes it easy for administrators to roll out upgrades of 
Cisco WebEx Connect with the optimized use of network bandwidth. Administrators who rely on Cisco 
WebEx to roll out the latest updates can continue to do so with no or minimal settings. Administrators who 
have a complex environment can use fine controls exposed in Cisco WebEx Connect Administration Tool 
to manage the rollout. 
 
With the auto upgrade feature, administrators can  

• specify a baseline version to ensure all users use the baseline or later version 

• select a specific version of Cisco WebEx Connect for the rollout 

• specify the off-peak business hour or day to roll out the software  

• roll out software in phases, targeting users in specific regions in every phase 

• optimize bandwidth utilization by hosting upgrade binaries on premise (advanced option) 

Version 7.0 of Cisco WebEx Connect optimizes bandwidth utilization by downloading only the required 
components instead of downloading the whole client binary. The Cisco WebEx Connect software 
eliminates spikes in bandwidth utilization by randomizing download time and doing downloads in the 
background. This feature also automates upgrades on controlled desktop environments without requiring 
manual intervention by administrators (controlled desktop environments prevent users from installing 
software on their own). During the upgrades to future versions, administrators will realize the benefits of 
these enhancements introduced in version 7.0. 
 
Customers who have not made any changes to Automatic upgrade policy settings need not take any 
actions. These customers will continue to receive upgrades whenever Cisco releases new version. 
 
Customers who have disabled automatic upgrades through policy actions will see their upgrade mode 
set to Custom, and new upgrades will not be rolled out automatically. Customers can choose to roll out 
the upgrade at the date and time of their choice. Customers will also have advanced features to select 
appropriate version and do phased upgrades to a targeted set of users. 

Password expiration 
through email 
notifications 

Third-party XMPP clients, such as Pidgin and BeeJive do not display appropriate error messages when a 
user attempts to sign in with an expired password. 
A new administration feature sends an email notification whenever a user attempts to sign in with an 
expired password, allowing users to take action to reset the password. 

Miscellaneous 
features: 

• Administrators have new controls to disable broadcast messaging and screen captures.  

• The user interface for adding and editing users has been streamlined to improve readability. 

Org Admin Application 
within Connect Client 

Starting with version 7.0, the Cisco WebEx Connect Administration Tool will be available only through the 
web browser. The Cisco WebEx Connect Administration Tool application will no longer appear within the 
My WebEx section of Cisco WebEx Connect. Instead, administrators will see the link to the Cisco WebEx 
Connect Administration Tool application within My WebEx. Administrators can also access the Cisco 
WebEx Connect Administration Tool by pointing to http://www.webex.com/go/connectadmin.   
 
The Cisco WebEx Connect Administration Tool requires Firefox version 3 or later. 

Cisco Unified 
Communications 
Integration 

The following features have added to the Cisco Unified Communications Integration 

• Visual voicemail: With the introduction of the Visual Voicemail feature in version 7.0, voicemail 
server settings have been added to Cisco WebEx Connect Administration Tool.  In the Voicemail 
tab of the Unified Communications settings, the administrator can configure the default 

http://www.webex.com/go/connectadmin�
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voicemail server for Visual Voicemail-enabled clusters.  In the Edit Clusters window (under the 
Clusters tab) the administrator can turn on Visual Voicemail and also enter specific Voicemail 
server information, if applicable. 

• One download for Cisco UC Integration for Cisco WebEx Connect: In version 7.0, the need to 
manage separate downloads for Cisco UC Integration for Cisco WebEx Connect has been 
removed. This integration is now built into the standard Connect installation. 

• The Cisco UC Integration features for Cisco WebEx Connect version 7.0 now replace the Cisco 
WebEx Connect Click-to-Call. 

Managing meetings The Cisco WebEx Administration Tool has a new Enable Meeting Integration option that controls the 
Meetings integration within Cisco WebEx Connect version 7.0. 
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Known Issues/Limitations 

IBM Lotus Notes • If a user upgrades to version 7.1 using automatic upgrade and has IBM Lotus Notes open on their 
computer, the user  needs to close and reopen Lotus Notes on their computer after upgrading  in 
order for the meetings list to appear in the Meetings tab 

• In order for meetings to appear in the Meetings tab, the user must open and sign into Lotus Notes 
before signing in to Cisco WebEx Connect. 

• If a user clicks the More Details link of a recurring meeting for an instance other than the first 
instance of the meeting while the Lotus Notes Calendar is open, an error message appears. This is 
a known Lotus Notes issue https://www-304.ibm.com/support/docview.wss?uid=swg21320626. 

• If the time zone of the operating system has changed, Lotus Notes needs to be restarted for the 
setting to take effect. 

• For a meeting scheduled in Lotus Notes, if a user starts an online meeting instantly from the 
Meetings tab and then signs out, when they sign in again, the Start button is active again, even 
though meeting is already in progress. 

• If a user signs into Cisco WebEx Connect and cancels before entering the Lotus Notes password 
in the resulting prompt, when they sign into Cisco WebEx Connect again, they will not be 
prompted for the password. This is a Lotus Notes limitation, where Lotus Notes will remember the 
state set by the user. User needs to restart Lotus Notes in order to enter password again. 

• All-day meetings are defined from 4 am to 8 pm in Lotus Notes; as a result, the times for all-day 
meetings appear as 4:00-20:00 in the Meetings list. 

Sharing status may be 
inaccurate for older 
WebEx sites 

• If a WebEx meeting is started on a site older than WBS27 SP22, and the host shares his or her 
application or desktop, the status of an attendee in this meeting appears as “Sharing in a WebEx 
meeting,” even if they are not sharing. 

Tooltip line breaks on 
non-English sites 

• On a site that uses any language other than English, some words in tooltips have awkward line 
breaks. 

Microsoft Outlook and 
Microsoft Outlook 
integration 

• Calendar integration with Cisco WebEx Connect is not available with Outlook 2010 64-bit 

• When both Cisco WebEx Connect and Microsoft Outlook are running, if you restart Cisco WebEx 
Connect, Microsoft Outlook will lose its connection to Cisco WebEx Connect. Once you restart 
Cisco WebEx Connect, you must either sign in to Cisco WebEx Connect manually from Microsoft 
Outlook or close Microsoft Outlook and open it again. 

• If you start Microsoft Outlook and then start Cisco WebEx Connect, Microsoft Outlook will not show 
the presence status for your contacts from Cisco WebEx Connect until you initiate some action in 
Microsoft Outlook. 

• Status (previously called “presence”), IM, and call integration are not supported in Microsoft 
PowerPoint. 

• In Microsoft Outlook 2007, it is not possible to right-click to call contacts that are not listed in the 
user’s Contact list. 

• It is not possible to right-click to IM a contact in Microsoft Word and Microsoft Excel. 

Contact status • Occasionally, status does not show properly in Microsoft SharePoint because of its dependency 
on certain Microsoft Office components. A workaround is documented by Microsoft at 
http://support.microsoft.com/kb/833714. 

• If a contact is added directly in Microsoft Outlook 2010, it may take a few seconds for the status to 
appear. 

• If a contact changes their profile information in Cisco WebEx Connect, the user has to hover on the 
contact’s name in Outlook before the changed information is displayed. 

https://www-304.ibm.com/support/docview.wss?uid=swg21320626�
http://support.microsoft.com/kb/833714�
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• After installing Cisco WebEx Connect, Outlook needs to be restarted in order for the contact 
status to show.  

Starting WebEx meetings 
with earlier versions of 
WebEx 

• For WebEx versions earlier than WBS27, you cannot start a WebEx Meeting Center meeting from 
Cisco WebEx Connect unless you have selected a Meeting Center meeting type in the One-Click 
settings on the WebEx site. 

IM window • Email addresses need to follow mailto: format in order to appear as a hyperlink in the conversation 
window [418977]. 

• When using Internet Explorer 6.0, if a user makes a phone call and then switches to an IM window, 
and additional space for a scroll bar appears even though there is no need for a scroll bar. 
[418381]  

Screen capture  • The screen capture feature is not supported in group chat sessions. 

• For users who have older versions of Cisco WebEx Connect, screen capture images are sent as a 
file transfer. 

• The screen capture feature is not supported with other third-party IM software.  

• The screen capture feature is not supported with Cisco WebEx Connect Web IM. 

• The screen capture feature may be blocked by a pending file transfer. [410724]  

Windows default device 
support 

If a Windows XP SP2 or SP3 user has the Use My computer's Default Audio Device option turned on in 
Cisco WebEx Connect, and the user starts a PC-to-PC call with one audio device, ends the call, switches to 
another device while Cisco WebEx Connect is still open, and then starts another PC-to-PC call, audio may 
still be heard from the initial device. 
 
To resolve this problem, the user should restart Cisco WebEx Connect so it will use the new audio device. 
[420770] 

IM Federation with 
Microsoft OCS and IBM 
Lotus Sametime 

• If a Microsoft Office Communications Server (OCS) or IBM Lotus Sametime user logs into the OCS 
or Sametime software respectively, a Contact List Request may appear for the Cisco WebEx 
Connect user if that user had previously accepted a Contact List Request for the same OCS or 
Sametime user but had not added the contact to his or her contact list (in other words, the OCS or 
Sametime user was an Observer). 

There are two workarounds for this problem: 

o Add the user to your contact list by turning on the Add this person to my contact list 
option, and accepting the contact list request. 

o Block the OCS or Sametime contact by selecting Block in the Contact List Request dialog 
box. 

• Under certain scenarios, Cisco WebEx Connect users always see a Contact List Request from an 
OCS or Sametime user, even if they had previously denied the request by selecting Deny in the 
Contact List Request dialog box. 

The workaround for this problem is to block the OCS or Sametime contact by selecting Block in the 
Contact List Request dialog box. 

• OCS and Sametime clients may show Cisco WebEx Connect contacts in the OCS or Sametime 
software even after the Cisco WebEx Connect user has removed them completely from his 
contact list. This can lead to confusion between the Cisco WebEx Connect user and the OCS or 
Sametime user because the OCS and Sametime software will not show a status for the Cisco 
WebEx Connect user. 

• Cisco WebEx Connect custom statuses, such as “On the phone” or “In a WebEx Meeting,” may not 
be visible or be reflected correctly in the OCS or Sametime software. 
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• A Sametime user may not be able to send an IM to a Cisco WebEx Connect user if the user status 
is “Away,” because Sametime interprets the status as “Do not disturb” or “Busy.” 

• An OCS user may see a Cisco WebEx Connect user’s status as “Available” when the user’s status 
is actually “Idle.” 

• Cisco WebEx Connect emoticons may not translate well in the Sametime or OCS software and 
vice-versa. 

• A Sametime user may receive a “blank” message when communicating with a Cisco WebEx 
Connect user who is signed in to Cisco WebEx Connect Web IM and that user then signs off. 

• A Sametime user may receive “blank” messages when a Cisco WebEx Connect user is typing a 
message—this is because the Sametime client does not interpret “typing indicators” correctly. 

• An OCS user cannot federate with a Cisco WebEx Connect user if the Cisco WebEx Connect 
username contains the quote mark character ( “ ). 

• OCS rejects hyperlinks that contain extensions on its blocked list. 

Issues with third-party 
XMPP software 

• Some third-party XMPP software applications such as Pidgin and PSI, do not support the Decline 
feature, and when you click the Cancel button in Pidgin, it does not do anything. As a result, a 
group chat invitation that is sent from Cisco WebEx Connect to a third-party application may not 
receive an “accept” or “reject” response. 

• When a Cisco WebEx Connect user ends a desktop sharing session, third-party applications may 
show the internal commands being exchanged to the end user in the IM window. 

• Some third-party applications do not support HTML rendering in the same way Cisco WebEx 
Connect does; for example, if the Cisco WebEx Connect window has a “Here” link, some third-
party applications cannot produce the URL. 

• Some third-party applications, such as MomentIM, do not support server side blocking (XEP-0016, 
privacy lists). As a result, a Cisco WebEx Connect user may still see a user’s presence status after 
being blocked from the third-party application and the user of the third-party application may still 
receive instant messages from the Cisco WebEx Connect user. 

Secure Real-Time 
Protocol (SRTP) 

The Cisco Unified Communication Integration with Cisco WebEx Connect version 7.0 does not support 
Secure Real-Time Protocol (SRTP), even though the user interface still shows settings for that protocol. 

Cisco Unified 
Communication 
Integration and DTMF 
signals 

Although the Cisco Unified Communication Integration with WebEx Connect version 7.0 may send dual-
tone multi-frequency (DTMF) signals while the call is considered “in progress,” it does not send tones.  

Cisco Unified 
Communication 
Integration Visual 
Voicemail 

• Users who receive forwarded voicemails with an additional message sent by the forwarder may 
not be able to play the entire voicemail message.  [418989] 

• Timestamps for received voicemails may be incorrect if the corresponding Unity server’s time is 
not set to GMT. [419293] 

• Occasionally users may have connection issues to Cisco UC integration with Cisco WebEx 
Connect or with Visual Voicemail when connecting through a virtual private network (VPN).  
Signing out and back in to Cisco WebEx Connect should resolve these issues (assuming there are 
no network issues). [418915] 

• Users who have special characters in their Cisco Unified Communications Manager usernames 
may experience problems receiving voicemails.   [417970] 

• Users are not able to sign in to Visual Voicemail services if any of the following conditions are true: 
the user password is locked, the user password has expired, or the mailbox is over its limit and 
cannot send or receive messages until some are deleted. [417832, 417796, 417776, 414663] 

Problems making calls 
with phone tab 

A user may experience problems making phone calls with the Cisco WebEx Connect Phone tab, and the 
user’s phone number may blink continuously. If more than one user assigned to the Cisco Unified 
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Communications Manager is experiencing these problems, it may be related to a known Cisco Unified 
Communications Manager Defect (CSCta67626). To resolve the problem, The Cisco Unified 
Communications administrator should restart the TFTP server for the impacted cluster. Refer to the 
Administration Guide for Cisco Unified Communications Manager to determine how to restart the TFTP 
server. 

Language support issues 
for global users 

• Spaces features are available only in the English language. 

• The desktop sharing floating icon tray is available only in the English language. 

• When a user signs in to Cisco WebEx Connect in one language and switches to another language 
in the same session, any subsequent error messages are displayed in the language that was 
selected when the user originally signed in.  

• The Cisco WebEx Connect Administration Tool is available only in the English language. 

• Cisco WebEx Connect online help does not contain content about Spaces for languages other 
than English. 

Windows 7 Support • Documents stored in spaces in the Files tab can be opened only in read-only mode in Microsoft 
Windows 7; these documents cannot be opened in Edit mode. This problem is caused by an issue 
with the Microsoft Windows 7 operating system. Currently, there is no estimate on when a patch 
will be available from Microsoft to correct this problem. 

Accessibility • Spaces features and Calendar tab elements are not keyboard accessible. 

• Accessibility features do not work in the broadcast message dialog box. [410862] 

Cisco Unified 
Communications 
Integration for Cisco 
WebEx Connect 
conference roster issues 

If conference calls cross multiple Cisco Unified Communications Manager clusters, conference roster 
information may be incorrect.  Users may notice this condition by seeing incorrect Caller ID and/or 
incorrect call status (connected/disconnected). This problem is a known limitation of Cisco Unified 
Communications Manager. [413404],[416129] 

Proxy connection 
support for Cisco Unified 
Communications 
Integration for Cisco 
WebEx Connect 

When a user’s PC accesses the Internet through a proxy, the Cisco Unified Communications Integration for 
Cisco WebEx Connect may not successfully connect. [ 413976] 

Cisco WebEx Connect 
features that are different 
or are not supported in 
Cisco WebEx Connect 
Web IM 

• The following Cisco WebEx Connect features are not available for Cisco WebEx Connect Web IM: 

o Spaces 

o Calendar  

o Offline messages 

o Outlook integration 

o Chat archive 

o File transfer 

o PC–to–PC calling 

o Video calling 

o Audio conferencing 

o Desktop sharing 

o Scheduling a meeting 

o Text editor 

o Custom sounds 

o Multiple languages (only English and French are supported) 
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• The “Idle,” “In Meeting,” and “In WebEx Meeting” status messages are not supported.  

• The “Away” status message is based on the amount of time the user is away from Cisco WebEx 
Connect Web IM. 

• Meeting reminders appear only for the default site that the user has configured in Cisco WebEx 
Connect. 

• Meeting information is cached every 30 minutes. If a meeting is scheduled after the last cache and 
start time, the reminder does not appear. 

• Users cannot take a picture using a webcam for use in their profile. 

• If a user invites contacts in a group chat to a meeting and that meeting has started, it is not 
possible to invite a new contact to that meeting automatically. 

• If Directory Groups are turned on, and a user adds a “Friendly Name” for a contact who is also a 
part of a Directory Group, the contact’s “Friendly Name” also appears in the Directory Group. 

• In Internet Explorer, it may take a few minutes after a user logs in to display the status for contacts, 
especially if the Contact list is long. 

• In Internet Explorer 8, the word wrap feature does not work when typing a message in the IM 
window. 

• If two windows are too close to each other or overlap, it may not be possible to move or close 
them. 

IM logging and archiving • If the IM logging feature is turned on for a user, and the user has end-to-end encryption turned on, 
the end-to-end encryption policy is turned off for the user. 

• Users who have the IM logging feature turned on must use either Cisco WebEx Connect version 
6.5 or later or Cisco WebEx Connect Web IM, even though users are currently not prevented from 
logging in to an earlier version of Cisco WebEx Connect. 

• If the IM logging feature is turned on for a user, and the user also has an end-to-end encrypted IM 
session open with a user who does not have the IM logging feature turned on, when the logged 
user signs into Cisco WebEx Connect again, the user may receive the error “Unable to establish a 
secure session. Your contact’s company prohibits sessions that are not secure, so this session is 
being disallowed.” When this message appears, one of the users must close the IM session and 
start a new one. 

• If the Cisco Unified Communications integration is turned on, dialing a non-existing phone number 
(111111111) results in the following additional message being logged: 

[<Time stamp>] 111111111:  
NOTE: Communications with loggeduser@mycompany.com are logged. 

• In an IM session between two logged users, the notification (a statement stating that the session is 
being logged) is displayed again if one of the users experiences a network disconnect or 
reconnect. 

• In an IM session between two logged users, the notification is not displayed when one of the 
logged users signs out, signs back in, and then starts an IM session with the same user. 

• In an IM session between a logged user and a non-logged user, the notification is not displayed 
when the non-logged users signs out, signs back in, and either party then starts an IM session with 
the other. 

• In situations where a user logs in simultaneously from more than one IM client, the notification may 
appear more than once 
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AV with policy restricted 
incompatibility between 
version 7.0 and earlier 
versions  

If a user of Cisco WebEx Connect version 7.0 who is not VoIP-policy restricted starts a chat with a user of an 
earlier version of Cisco WebEx Connect who is VoIP-policy restricted, and then the first user starts 
Conference Computer in the conversation window, the user of the earlier version sees no prompt, while the 
first user is incorrectly notified that the second user is joining the conference. [419723]  

Unable to search the 
Microsoft Outlook Global 
Address List for contacts 

The Add Contact dialog box has been simplified so that users searching for contacts to add to their contact 
lists can search only the Cisco WebEx Connect user database. Users are no longer able to search the 
Microsoft Outlook Global Address List (GAL) for contacts. 

Unable to send a 
message in Discussions 
within an open Space 

If a user has a particular Space open for an extended period of time, the user may be unable to send a 
message in the Discussions tab. The workaround is to close the Space and reopen it to continue to 
participate in sending messages in the Discussions tab for this particular Space 

Desktop sharing • The ToolTip indicating who has control of the desktop sharing session incorrectly shows the 
contact username instead of the contact display name (for example, the First Name and Last 
Name). 

• Guest users of Cisco WebEx Connect version 5.1 cannot view desktop sharing that was started by 
a user of Cisco WebEx Connect version 7.0. 

• When a user of Cisco WebEx Connect version 7.0 ends a desktop sharing session with a user of a 
third-party application, the third-party application user receives an incorrect notification that the 
Cisco WebEx Connect user has canceled the invitation. [416579] 

Unable to receive 
message when signed in 
from both Cisco WebEx 
Connect and Psi 

If you have signed in to Cisco WebEx Connect and to the Psi instant message application (http://psi-
im.org/) at the same time and have set your status to “Custom Away” in Cisco WebEx Connect and to 
“Away” in Psi, you may not receive messages correctly on Cisco WebEx Connect.  

Unable to view the 
business card of some 
contacts 

You may not be able to view the business card of some of your contacts who are not part of your company 
or organization. This issue may occur if any of your contacts who are not in your organization have set their 
profile permissions to My Organization and/or My Network and your contact has not added you as a 
contact to their contact list. 

Profile Profile updates take some time to display for a contact after a change in Profile permissions. [418855] 

Compatibility of the 
Show contact pictures 
in my contact list option 
with previous versions of 
Cisco WebEx Connect 

Checking the Allow users to set “Show contact pictures in my contact list” option in the Cisco WebEx 
Connect Administrative Tool causes the option Show contact pictures in my contact list to be unchecked 
for Cisco WebEx Connect users who are using a version earlier than version 6.1.0. The workaround for this 
problem is to uncheck the Allow users to set “Show contact pictures in my contact list” option and check 
the Show contact pictures in my contact list option in the Cisco WebEx Connect Administrative Tool. See 
the following illustration: 

 

This workaround is not necessary once all users have upgraded to version 6.1.0 or later of Cisco WebEx 
Connect. 

Cisco WebEx Connect 
version 5.x and 6.0 or 
later functionality 
incompatibility 

The following Cisco WebEx Connect features do not work between Cisco WebEx Connect version 5.x and 
Cisco WebEx Connect version 6.0 or later: 

• File transfer  
• Group chat  
• PC-to-PC call  
• Video call  
• Click-to-conference  
• AES encryption  
• Rich messages (for example, “In a WebEx Meeting,” “On a video call,” and so on)  
• Outlook Integration status display (for example, the Outlook and Calendar event participant list): 

o In version 6.0 or later, users cannot see the status of version 5.x contacts (applies only to 
version 5.x contacts that are not on the version 6.0 or later contact list)  

http://psi-im.org/�
http://psi-im.org/�
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o In 5.x, users cannot see the status of version 6.0 or later contacts (applies only to version 
6.0 or later contacts that are not on the version 5.x contact list) 

Dragging and dropping a 
file to the desktop 

Dragging and dropping a file from the IM window that has been sent through the file transfer feature of 
Cisco WebEx Connect to copy the file to the Windows desktop is not supported. [336684] 

Status for Cisco WebEx 
Connect version 5.x and 
version 6.0 or later 

If a Cisco WebEx Connect version 6.0 or later user invites a Cisco WebEx Connect version 5.x user into a 
space, the version 6.0 or later user cannot view the status of the version 5.x user. The same is true if a 
version 5.x user invites a version 6.0 or later user to a space; the version 5.x user cannot view the version 6.0 
or later user’s status. [326647] 

Uninstalling Cisco WebEx 
Connect on Windows 
Vista 

When uninstalling Cisco WebEx Connect on the Windows Vista operating system, the User Account 
Control dialog says that an “Unknown Publisher” wants to access your computer and asks if you want to 
allow it to continue. The “Unknown Publisher” should be listed as Cisco WebEx Connect. The user should 
click Allow and Cisco WebEx Connect will be uninstalled. [335193] 

Desktop sharing on 
Windows Vista 

If the Host of a desktop sharing session is running the Windows Vista operating system with their Windows 
color scheme set to “Window Aero,” some areas of the desktop may not be visible to attendees of the 
desktop sharing session. [336491] 

Starting a WebEx 
meeting after a previous 
meeting ends 

Users may not be able to start a new WebEx meeting if they start it immediately after joining a meeting that 
has ended. If a user receives a WebEx meeting invitation, but the host ends the meeting before the user has 
joined the meeting, the user will receive an error when they click on the "Join" link. The user will then be 
unable to start a new meeting for 90 seconds. After 90 seconds, the user will be able to start a new WebEx 
meeting. [334225] 

Meeting list • If a host schedules a meeting on a WebEx site and then imports it to Microsoft Outlook, but does 
not specify the WebEx site account in Cisco WebEx Connect, and then the host signs in to Cisco 
WebEx Connect, the meeting will display the attendee view of the meeting and when the host 
clicks the join button, an error message will appear. [416845] 

• If a host schedules a meeting on the WebEx site, and then starts the meeting in the Cisco WebEx 
Connect meeting list, the meeting will be temporarily removed from the meeting list after the 
meeting has ended. [414892] 

WebEx meeting issues 
for previous versions of 
WebEx 

For meetings that were scheduled with WebEx versions earlier than WBS27 SP22, The following conditions 
may occur with Cisco WebEx Connect: 

• The instant meeting’s topic may be hardcoded. [411367] 

• Garbage characters may appear for the meeting information after starting an instant meeting from 
Cisco WebEx Connect. [409254] 

• Users cannot import iCalendar file into Microsoft Outlook 2007 and earlier versions. [412957] 

• When a meeting is rescheduled, notifications of the meeting changes cannot be imported to 
Microsoft Outlook. [415910] 

Inviting offline users to 
audio conference 

If the host of an audio conference does not have Microsoft Outlook set up on his or her computer, email 
invitations will not be sent to offline users to join the audio conference. [328447] 

Saving a file that was 
open during a GSB 
switchover 

If a file is open during a GSB switchover, the user may be unable to save the file. The user will need to close 
the file and then reopen it in order to proceed. [340665] 

Storage calculation Storage use is calculated only when the user signs in and not afterwards, so if a user uploads documents, 
the total storage use amount will not include the storage used by the recently uploaded documents until 
the next time the user signs in. [334937] 

Search The Search feature has the following issues: 
• Partial word searches are not supported. For example, searching for “opi” will not result in the word 

“topic” being returned, but “opinion” will be returned in the results. [339934]  
• Mixed language search is not supported. [333547] [332947]  
• Special characters are not supported in search queries. [301191] 

Copy and paste 
shortcuts   

The Windows copy and paste shortcuts are not supported in the Add Contact, Invite Contact, or Broadcast 
Message dialog box. [412707] 
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Online help Online help will not work with FireFox 3.x [331181] 

Browser widget Websites that redirect to another page are not supported in the Browser widget. [281478, 315677] 

IM LDAP groups Poor performance sometimes occurs with large LDAP data in Cisco WebEx Connect. [416118, 415726] 

File upload File upload will not work during failover to GSB. [335111] 

GSB • Cannot upload files during failover to GSB. [335111] 

• Cannot migrate an organization from AOL to Jabber if the organization has failed over to GSB. 
[341521] 

• If a file is open during a GSB switchover; the user may be unable to save the file. The user will need 
to close the file and then reopen it in order to proceed. [340665] 

Org Migration from 
version 5.1 to version 6.0 
or later 

Some contacts may be missing after migrating from Cisco WebEx Connect version 5.1 to version 6.0 or 
later. At the time a user logs in to Cisco WebEx Connect version 5.1, the Cisco WebEx Connect application 
saves the user’s contact list data to the database. If a user adds new contacts to his or her contact list, this 
new contact data is not saved to the database until the user signs out of Cisco WebEx Connect and then 
signs in again. As a result, if the user’s company migrates from version 5.1 to version 6.0 or later, those users 
who have added new contacts and have not signed out and signed back in to Cisco WebEx Connect 
version 5.1 to save the newly added contact data to the database prior to migration will not see these newly 
added contacts when they use Cisco WebEx Connect version 6.0 or later. 
 
To avoid this problem, it is recommended that customers be informed about this issue before their 
respective migration date, so they can notify their user base. All users who have added new contacts to the 
contact list will need to sign off Cisco WebEx Connect version 5.1 and then sign in to Cisco WebEx Connect 
version 5.1 again before their company migrates Cisco WebEx Connect users and contacts from version 
5.1 to version 6.0 or later. If a user does not follow this procedure, their newly added contacts will not be 
migrated to Cisco WebEx Connect version 6.0 or later. [340925] 

Cisco WebEx Connect 
Administrative Tool 

The Cisco WebEx Connect Administrative Tool has the following issues: 

• When an administrator clicks the right click button in the Cisco WebEx Connect Administrative 
Tool, the right-click menu may appear in a different location instead of near the mouse cursor. 
[338492]  

• When there are multiple groups with same name, the administrator will not be able to specify one 
or more of those groups for a user. In order to specify the group for the user, the administrator 
should rename the group name to a unique name and then try again. [341162] 

Registration page Users who register themselves for a Cisco WebEx Connect account may not receive a WebEx Meeting 
Center account if the number of WebEx Meeting Center accounts has exceeded the licensed limit. The 
user will be unable to start and join meetings. This condition occurs only for customers using the Cisco 
WebEx Connect integration to WebEx Meeting Center. To resolve this problem, contact your Cisco WebEx 
representative to increase the number of WebEx Meeting Center account licenses. [340655] 
Users cannot use keyboard controls to select items from a list (for example, the Country name list) in the 
registration page. Users can only use the mouse to select items from the list. [339440] 
On the Additional Information page of the registration page, when selecting the country code from the list 
for the Business Phone and Mobile Phone options, a flag icon appears next to the country name for most 
countries, and that flag also appears next to the phone number once the code has been selected; however, 
many countries do not have a flag icon listed, so no flag icon appears next to the phone number. [339398] 

Cisco WebEx Connect 
integration with WebEx 
Meeting Center 

Customers who have Cisco WebEx Connect integrated with WebEx Meeting Center should be aware of 
the following issues: 

• After Cisco WebEx Connect is integrated with WebEx Meeting Center, the user may not see their 
picture in the My WebEx My Profile page of the WebEx Meeting Center website, and may need to 
upload their picture again by going to My WebEx > My Profile. [336813]  

• The user’s business phone and/or mobile phone number may appear correctly in Cisco WebEx 
Connect, but may not appear in the My WebEx My Profile page of the Meeting Center website. 
This problem typically occurs if there are special characters in the telephone numbers in the Cisco 
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WebEx Connect user profile. To correct this problem, the user should make sure the phone 
number format in their Cisco WebEx Connect user profile conforms to the format required for the 
Meeting Center account profile. [335494]  

• Administrators cannot activate the WebEx Meeting Center account within Cisco WebEx Connect 
for a user whose WebEx Meeting Center account has been deactivated. To activate the WebEx 
Meeting Center host account, the administrator must use WebEx Meeting Center Site 
Administration. [333378, 333075]  

• When an administrator is changing a user’s status in Cisco WebEx Connect from Inactive to Active, 
the administrator may be unable to activate the WebEx Meeting Center account for that user. To 
activate the Meeting Center host account, the administrator must use WebEx Meeting Center Site 
Administration. [331088]  

• Users will no longer see the Change Password link on the WebEx Meeting Center website or in 
WebEx Productivity Tools, because once Cisco WebEx Connect has been integrated with WebEx 
Meeting Center, users should change their password only from the Cisco WebEx Connect 
application, and use the same password for both Cisco WebEx Connect and WebEx Meeting 
Center. [329935]  

Cisco WebEx Connect administrators who do not appear as administrators in the WebEx Meeting Center 
website can still create and manage Meetings accounts. [326973] 

Sign in • .In some cases you cannot end the Cisco WebEx Connect version 7.0 task from the Windows Task 
Manager. 

• Sign-in windows are still editable when a user signs in with an expired username. 

Automatic upgrades • Uninstalling Cisco WebEx Connect version 7.0 does not cause the Automatic Upgrade dialog box 
to close. 

• Cisco WebEx Connect automatic upgrade time zone widget uses the local operating system 
language instead of using the English language. 

Plantronics Unified 
Runtime Engine (P.U.R.E.) 
integration 

PURE Integration remains available for PC-to-PC calls, but in Cisco WebEx Connect version 7.0, Cisco 
Unified Communications Integration with PURE is not supported. 
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Related Documentation 

Refer to the following documentation for additional information about Cisco WebEx Connect: 
 
• Cisco WebEx Connect online help  

http://support.webex.com/webexconnect/71/user/en_US/help/index.htm   

 
• Cisco WebEx Connect Administration Tool online help  

http://www.webex.com/webexconnect/orgadmin/help/index.htm   

http://support.webex.com/webexconnect/71/orgadmin/en_US/pdf/WebEx_Connect_Administrator_Guide.pdf  

 
• Cisco Unified Communication Integration Configuration Guide 

http://www.cisco.com/en/US/products/ps10627/products_installation_and_configuration_guides_list.html   
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